
GEOG357: Fall 2022 Lab 2 (A – B) 
                Digital numbers (DN) and Unsupervised classification 
 

 

A. Digital Numbers 

0. Copying your own image files 

 All files for labs are in the folder: L:/labs/geog357 

In this (combined) lab, we will create new layers, and therefore you need your own copy of the 

image .pix files.  

In the file manager window, right-click, and select new folder 

I would name it      geog357   (no spaces) 

I strongly recommend avoiding spaces in names and also avoid cap letters- think like a computer ! 

Use the file manager to copy these two files from L:/labs/geog357 into your geog357 folder:     

pg14sept2011.pix        and     pg3sept2013.pix 

1. Color Image Display and Set-up 

Start Catalyst software and Load Satellite Imagery in Focus 

file -> Open and select:   pg14sept2011.pix   

            The scene has been clipped to reduce size and the need to pan  

Resize to get best display .. you should be able to see almost the whole dataset without panning; 

resize by extending the corners, but I recommend you don’t maximise the window. 

The pixels are 30 x 30 metres in size – standard for most Landsat imagery 
 
Note the difference throughout between RGB – the display guns and the image bands (1-7) 

Image Bands: Refer to the individual Landsat TM bands ranging from 1 -7.  

Channels: the database layers -initially the same as the band numbering 

Display guns (RGB): three planes can be displayed simultaneously in red-green-blue (RGB). 

Displaying the same band or channel three times in RGB produces a gray tone image. 

 
 
a. Display and Enhancement - review 
 
The initial display usually has poor contrast; default bands 1-2-3 are in R-G-B  

('reversed': blue band is shown in red, red in blue) -> 'flip' bands 1 and 3 by: 

 right-clicking filename in ‘Maps’ tab and RGB mapper - click 3 in red and 1 in blue  (close) 

 



Enhance:    right-click -> enhance - root- usually works best (or linear) 
You can also enhance using the icon in the 2nd row along the top under the ‘scissors’, and 
left of the sun and shade icons 

 

Optimise the display to SWIR-NIR-Red 

 Now change to 5-4-3 maximum contrast in the same way (and enhance again) 

• We can compare the 5-4-3 and 3-2-1 displays more easily by adding a new layer 

• Layer-add-> RGB and in the ‘wizard pop-up box’ click on 3 then 2 then 1, finish -> and 

as always, enhance  

• Now click the normal colour display on and off to compare with the 543 - note the 

contrast in the 543 and advantages of using IR:  veg contrast, land v water, and no haze. 

 

2. View the individual bands in grayscale: 
 

Layer-add-grayscale; select band 1 and finish .. and as always enhance as needed 

 

Right-click on the grayscale layer in the Maps list and select RGB mapper – note that all 3 
colour, guns are ticked for Band 1; change this to band 2, close and enhance as needed. 
 

Do the same to view bands 3-7 (always enhance as needed) 

 

Note that bands 1-3 are similar, bands 5 and 7 are similar, band 6 is ‘fuzzy’ – larger pixels. Some 
striping will be evident from the low contrast and limited data range in band 6. 

 

2b. View thermal band in Pseudocolour 

Layer-add-pseudocolour and select band 6 - ‘enhance in this case may not be active’ although 

you can edit  the PCT (PseudoColour Table) 

3. Examining histograms  
 

 

Highlight the 321 display layer name and View the histogram by selecting: 

Right-click -> histograms  OR select (in menu bar at top) Layers -> Histograms 

 

This displays the histograms for the selected RGB (note that all operations relate to the layer 

highlighted in the TOC, not the one displayed, unless they are the same. 

 

Get more detail and information for each one by clicking on its histogram (yes, try it!)  

 

Note: the 3 histograms are similar in shape (all are visible bands);  

All have a low range of values compared to the 0-255 possible range 

Also. the minimum DN decreases as wavelength increases as bands are less affected by haze - 

haze adds fake 'brightness' so there are no pixels with lowest values, especially for blue. 



 

Now highlight the 5-4-3 composite display 

View the histograms for this composite  

Generally, higher SD = higher contrast; The standard deviation value is an indication of data 

spread (lower for Visible), and the bimodal graphs for IR reflect the very low DNs for water. 

Check this out by clicking your mouse in water, view the DNs at the bottom  

The lowest SD is for Band 6 – a very narrow range, and there are only 0 values due to missing 

data (the black wedge in the SW corner). 

 

right-click on filename and this time select ‘numeric values’ – this gives you the DNs for the 7x7 

grid around the mouse location – these can be handy for local investigation. 

 

4. Adding vectors 

 
RS is mostly about images, but we can display (and also create) vectors. We will add a vector 

layer for the rivers: 

Layer dropdown -> add -> vector -> next 

Browse button -> navigate to  /home/labs/geog357/shapefiles and click on rivers.shp 

In the panel below, click on 1 (VEC) rivers    click on Finish, and Rivers will appear (in red) 

To change colour, right-click in Table of Contents vectors, colour -> blue 

 

You will see some mismatch between the vectors and image where either the rivers have 

changed or a result of pixel resolution. 
 

 

5. Landsat 8 OLI - 3 September 2013 

 
We will add an image from 2013 and shift to Landsat 8 OLI  data, with more bands than 

Landsat 5 TM, and 16-bit data so DNs are now potentially 0-65,535; there is also a higher 

resolution Panchromatic band (15 metres) 

 

File-> open   pg3sept2013.pix 

 

Band 1 is extra compared to Landsat 5 TM ('Coastal blue'- see table below) - note that the 

bands are nicely described with Landsat 8 so you know what they are. The standard RGB 

natural colour is now bands 4-3-2 but some displays already know this.  

Ensure you have 432 displayed and enhance - note the DN display at bottom - now in 16-bit 

View the histograms – they will look different with the 16 bit DNs.  

What is the general range - ignoring the outlier values in long statistical tails ? 



 

 
 

 

 

Change the band combination to 654 (=~TM543) enhance and view these histograms  

- remember to click on each one to expand and see the proper details. Now query the DNs in  

a. water b. coniferous                          c. deciduous 

 

you should appreciate why these relative values represent these types of features in visible, 

near and mid-IR, though its more complex than with the simpler Landsat 5 TM 8-bit data. 

 

Lastly, display the panchromatic band (from L: \geog357) in grayscale: 

Layer->add and select pg3sept2013pan.pix   enhance  

The pan band needs its own file, as it has higher resolution; flick from this to the colour 

composite to see the effect of the higher resolution in terms of detail e.g. UNBC campus. 

You will likely need to zoom in to see the higher resolution. 

 

You may have noticed that the RGB mapper shows bands for all files loaded – this can get 

confusing if you load too many, especially in the next section 

 

 

 



GEOG357: Remote sensing Lab 2  

B. Unsupervised classification 

General Goal: 

This lab involves identifying land cover types by using algorithms to identify pixels with similar 

multi-spectral Digital Numbers (DN) and spectral signatures 

For simplicity, remove the Landsat 8 files for now from the ‘project’ .. 

Switch to the Files tab and right-click on first the multispectral 2013 pix file – remove from project;   and 

then the PAN file – remove; then return to the Maps tab 

1- Bitmaps  

Traditional analogue mapping from panchromatic aerial photography uses interpretation and 

manual digitising. We'll simulate a digital process from one band ... this only works if a feature 

type has a unique set of DNs. Water reflects almost no NIR and thus has very low DNs in L5 TM 

Band 4 (L8 OLI Band 5). Extract water only - imagine you don't have a GIS layer for PG 

Click around in the water and note the highest general DN for water in Band 4 (Near IR) – 

numbers displayed in the green gun below the image - be sure not to catch any shoreline / mixed 

pixels. Note (and avoid) the two algae masses in Tabor Lake. 

You might also review the histogram for Band 4 to get an idea of the DN range for water. 

You might want to zoom in a bit, maybe around the two rivers confluence (“T'enneh”). 

 We will use this DN to try to identify ONLY water via the Threshold algorithm: 

Tools -> Algorithm Librarian -> click Find - and type THR  (then enter) 

It will find the algorithm and then click Open 

To reduce clutter, you might want to then close the algorithm librarian window. 

Tick channel 4 ....  the bottom panel should be checked on 'viewer' 

click on the Input params tab, enter 0 for minimum and a conservative value for water as 

maximum - go low at first below your estimated value, e.g. 17 so it’s easier to 'up' it (there are no 

DNs below 17) 

- click the Log tab and then Run (the screen shows the progress or errors) 

Some (but not all) water should fill with a default colour – perhaps red. 

Now up your maximum (Input params) to a value close to your estimated value and run again 

Is all the water now filled ?   right-click on the bitmap, select representation editor and it gives 

you # pixels that are water (1) and not (0) 



if some water areas are not coloured, highlight the layer on the left (in maps tab) and query the 

water DNs (Band 4).. possibly some water pixels are a bit higher; maybe you need to increase 

the maximum a bit more to cover these, but notice the bitmap starts to include shadows on the 

north side of the eskers north of the Nechako River. 

IMPORTANT POINT: when you read the DN values at bottom, they apply to whichever display 

layer you have active – it may not be the top one. Just as in GIS software, highlight the layer you 

are trying to query to be sure. If the active layer is the image, you see the 3 band DNs; if the 

bitmap above it is the layer, you will see 1 (water) or 0 (land) 

Eventually, you should find a value that hits just water and most of it – if you go too high, it 

starts to fill in non-water, but there is no perfect DN – either some water gets omitted or some 

non-water gets included.  Record what this value is (it will be an answer you will use later) 

Once you have your best number value, Go back to the first tab (files) in THR 

check the box below viewer, hit browse and navigate to your copy of pg14sept2011.pix 

Run again, and this time it will add a bitmap (1 or 0) = water or land to your file. 

It is NOT overwriting your file, just adding a bitmap to it 

NEVER NEVER NEVER accept the useless default of ‘untitled.pix’ 

 

Check by switching from maps to files in the TOC (table of contents), and this should list a 

bitmap as well as the rasters; switch back to the maps tab. 

The .pix file contains all layers – it’s not like an Esri shapefile, more like a geodatabase (gdb) 

Compare the bitmap with the city rivers GIS layer: 

Turn the bitmap on and off so you can see the vectors; they are not identical as the vectors were 

produced from higher resolution air photos, and may be more up to date than 2011. 

Much easier than manually digitising all the rivers and lakes.. !? - but maybe less accurate 

 

2. Classification Introduction  
 
Classification involves identifying a set of unique spectral signatures for a feature type in the image 

scene. We want our classifier to take advantage of maximum  information content available in the image, 

so we will choose relatively uncorrelated bands to run the classification e.g. 5-4-3 and NOT 3-2-1   

BAND CORRELATION  
You should notice the following for Landsat TM data:  

1. VIS (visual) bands show cultural features and in detail 

2. NIR shows the land/water boundary sharply. Water appears black 

3. SWIR shows dryness or inverse of moisture (high DN = low moisture)  

4. TIR shows basic variations in temperature (though we won't use this) 

Ensure you are zoomed out to show the full extent – symbol to left of zoom options 



To view correlation between any selected band pair, Select layer -> scatterplot  

Look at the correlation between the following bands. The more correlated the bands, the closer 

the plotted points fall along a straight line (one band is nearly a linear function of the other).  

Green v Red    r = 0.95 

Green v NIR  

NIR v SWIR1     r = 0.71 

Blue v TIR 

NIR v TIR 

SWIR1 v SWIR2 (5 v 7) 

you should see a high 'r' between visible bands, and less with IR (except maybe 5 v 7)  

r values correspond to the image data displayed – values will vary if you are zoomed in 

Q: what is the r value between the red and near-IR bands ? (note it down – you will need it) 

Review also the histograms:    layer → histograms 

 This displays the 3 bands in the composite and represent the VIS, NIR and SWIR. Click on each 

histogram to expand each one at a time: higher SD = higher contrast 

The standard deviation value is an indication of data spread (lower for VIS), and the bimodal 

graphs for IR reflect the very low DNs for water. 

 

3. Unsupervised Classification algorithms 

 
You will now see the difference between a band (recorded by the sensor) and a channel – which 

can store a band, but also any other data generated by the user. We will add empty layers - 

8-bit channels which can store classification results with up to 256 classes. 
 

You are ready to classify:  

• Analysis -> Image Classification -> Unsupervised 

• Select the file to use = your .pix file  

• Select New session 

• Click on add layer and add five (5) more 8-bit layers (channels) 

• We need to specify the display, input bands and output CHANNEL 

• Select TM bands 5,4,3 (R, G, B) as input channels (and tick in input column)  

• The colour ticks in the first 3 columns are simply what is displayed 

• Select the first  empty channel (8) as output  

• NOTE: the designated output channel will be overwritten, so if you specify a band 

number (1-7) you will LOSE the band data - so always double check output channel 

number  - it should be an empty channel. Someone often wipes out their data – Don’t let 

it be you! (but it is recoverable) 

• click OK 
 



 In the Classify window, select these options:  

• Algorithm: K-Means  
• Max class: 6  
• Max Iteration: 6 
• Min Threshold: leave as is 
• Max Sample Size: leave as is (with a bigger scene, we might specify a subset)  
• Show Report button: 'on' (depressed) 
• OK 

..  this shows the report for the 6 clusters, # of pixels in each, and average DNs for bands 3,4,5  

..  image displays in 'PC' (pseudo-colour), the new DNs are 1-6 (one number for each class)  

This report could be saved if needed for future work (but is not needed here) 

Can you visually identify the clusters as classes approximately? (do a quick check) 

tick the PC (classification layer) off and on to view the classification and the 543 composite. 

View the report also - it gives the number of pixels in each class, and the mean DNs 

It should be poor as there are too few classes - and iterations 

Right-click the Classification MetaLayer and select run classification 

Change the number of classes (clusters) to 10 - view the result, its better, but view the 

classification report - likely there are only 6-7 clusters containing most of the data  

Change iterations also to 10 - view the result, now most clusters have pixels. This shows the 

value of using at least 10 iterations.      review the report stats:  

Once more, Right-click the Classification MetaLayer and select run classification 

This time, try 12 classes/clusters and run classification again. This should seem better – click 

classification Metalayer off and on to compare with the image 

Can you match the cluster numbers with land cover types - click each colour to see which cluster 

it is, and try to visually match these against the list below. 

Change the colours for easier reading if you wish -  at the very least make the water cluster class 

blue, and coniferous forest dark green: expand ‘output’ checkmark and double-click on the 

legend colours to edit them.  [ or right-click on classification metacolour – edit PCT ] 

Note that some shadows get grouped with water – the north facing slopes of the esker ridges 

north of the Nechako River; next week we will see how this can be corrected.  



Q: Which is the band (3, 4 or 5) that best differentiates water and forest –– it might be a bit 

obvious, and why ?  (note down your answer) – review the report if you still have it, or query 

some water and forest locations for their DN values. 

Some cluster classes may be 'hybrid' or mixed, e.g. grassy areas could be regenerating cut areas, 

city parks, etc.. the bottom 3 clusters may intermix         

See which cluster numbers correspond to: 

• Water  

• Conifers 

• Deciduous trees 

• Industrial – urban 

• Residential - urban 

• Grass (e.g. soccer fields) 

• Agricultural fields 

• Cutblocks 

• Chip piles  

 

Simplified interpretation: 

•   Dark-green: coniferous. 

•   Light-green: deciduous. 

•   Pink: arable / agricultural. 

                                                         Yellow-green: Playing fields / golf courses 

•   Dark-purple: industrial. 

•   Light-purple: residential. 

•   Black: deep or sediment-free water. 

•   Blue: shallow or sediment-laden water. 

•             White: bright: Canfor chip piles (brightest feature on this image) 

 

 

Fuzzy k-means 

Select  Analysis -> Image Classification -> Unsupervised  

( …. new session, and pick an empty channel for the output – 9 (input = 543 as before) 

Go for 16 / 16 in the clusters and iterations  - how does this compare with the previous K-means?  

Does it do any better in mapping the classes above? Hard to tell with different colour tables. 

Note that it runs slightly slower because the clustering process includes the spread of pixels in 

each cluster and probability functions, not just which seed point / mean each pixel is closest to. 

 



ISODATA classifier 

Select  Analysis -> Image Classification -> Unsupervised  

( …. new session, and pick an empty channel for the output – 10  (input = 543 as before) 

Now select Isodata as the method. This time, you can make all options the default 16 minimum 

clusters, maximum, and desired clusters and 16 iterations. Again view the result, and the 

classification report - almost all clusters should have a fair number of pixels (or the clusters are 

'wasted'), and compare with the previous classifications. 

In order to display both or all 3 classifications, select  layer->add->pseudocolour,  

and select the previous classification channel (fuzzy k-means)  – the software should have 

labelled them suitably. Click the fuzzy / isodata layers off /on to compare with the underlying 

colour composite … it may be hard to objectively tell, but for some the isodata slightly retains 

homogenous areas within the same class – not very scientific, but hey it's only a lab ! 

Select which you think is the best classification of the ones you've tried for the next step - i.e. 

'maps' given class(es) to your satisfaction.... this is quite subjective - for a project or job, you'd 

spend more time on this. Check for example which one separates the residential areas in the bowl 

versus the light industrial areas (more purple in the 543 composite).  

Classify once more:       Analysis -> Image Classification -> Unsupervised  

but this time we'll add bands 2 and 7 as extra input as some people advocate using all bands,  

tick channel 11 for output and pick 543 as display, but tick 2,3,4,5,7 for input - you are not 

limited to 3 input bands, only visual display. Use your best algorithm (K-means, Fuzzy, or 

Isodata). Has it done any better than with only 3 input bands? hard to tell – I didn't think so. 

Some researchers also think too many inputs can 'confuse' the algorithm. 

4. Filtering / sieving the classification 
The classification will have isolated pixels, which are mostly undesirable 'noise'  

These can be reduced using the SIEVE algorithm 

In your 'favourite' classification, first note - what is the cluster number(s) for water .. this is so 

you can retain small lakes, as they may be meaningful.  

Tools -> Algorithm Librarian  

click the 'Find' button and type in sieve and then 'Open' [as you did with Threshold (THR)]. 

The parameters will be these: 

  input = ## (the channel number your best classification )  

 output port should be viewer -PCT (at first)  

Let's do a small sieve – 1 acre which is ~ 4 pixels (1 acre is about 60x60m) 

 Input params: 

 Polygon size threshold= 4;        Connectedness - can be 4 or 8  

 exclude values list = ##   (where ## is the class number for water)  

select log tab and run ...  



View the result, compared with the unsieved classification - click the sieve on and off and you 

should see the before and after;  

usually this would NOT be enough, so increase polygon size threshold to 11 (= 1 hectare), run. 

If suitable, now save  - run it again, specify your filename under the 'files' tab in sieve, as output 

at the bottom - make sure you name your copy of pg14sept2011.pix. You also need to ‘tick’ the 

file box so that this is now saved as a new channel in your file - check which one it is, by 

viewing your list of channels in the main tab on the left of the image, under 'Files' and expand 

the rasters list. You might also want to rename the layer from ‘Contents not specified’ to 

something like ‘sieve11’ .. double click on the name and type the new name. 

NOTE (again): NEVER accept the default filename 'Untitled.pix'. You must have all your data 

layers in the same file. and you should not have any file named Untitled.pix in your folders … 

I’ve added recent edits in RED to clarify .. especially in the last steps. 

 

5. Prince George 2013 Landsat 8 OLI image 

 

The Landsat 8 Operational Land Imager (OLI) has 16-bit data … DNs can range from 0-65,535 

(but rarely do) Since 2015,  both NASA Landsat and ESA Sentinel programs have 16 bit data.  

 

We could add the newer image to this 'project' but it's likely less confusing to start a new project 

– you can save the other one as a project e.g. pg2011 (.gpr) 

File-> New project 

 

Display (open) the 2013 image, using the optimal SWIR, Near IR, Red combination  – it has the 

extra band 1 (coastal blue), so the optimal combination is 654 instead of 543 for Landsat 5.  

 

1. Bitmap – create the water bitmap same as you did for the 2011 image, of course you’ll need a 

very different threshold value – Q: record this value 

 

2. Classification Intro: try the same scatterplot combinations as with the 2011 image– are the 

values any different ?   Q: What is the r value for Red versus Near-IR ? 

 

Check the 654 histograms for 2013 and review the range of DNs for the near-IR band 

Q: How do you interpret the double minor modal peaks for low DNs in the histogram ?   

( not present on the 2011 NIR band layer) 

 

3. Classification algorithms – no need to repeat everything – just do the one which you felt 

worked best – no prizes on this, it’s an intro lab, not a project or thesis. You’ll only need to 

create one new 8-bit channel for classification.  

Has the 16-bit image data helped better distinguish between water and the esker shadows ? 

 

Note the effect of the clouds and their shadows in the SW corner likely creating two extra 

classes– this shows why as much as possible we need ZERO clouds, not just low cloud cover… 

 



Now edit the class labels to what cover type you think they are by this process: 

Right-click on classification metalayer -> post-classification analysis -> class labelling  

        In the channel setup pop-up, select your classification layer 

 

Edit “class 01 etc..) to your best guess – water, deciduous etc.. 

Note that some classes might cover 2-3 clusters/colours and/or you might have a hybrid cluster 

for boundary pixels.   SAVE 

 

4. SIEVE the classification.  

Reminder: first tick on viewer-PCT and select e.g. 11 for 1 ha; then if happy, re-run with tick on 

your .pix file. As before, rename the new sieve layer (under ‘files tab’). It should have retained 

the new names you have applied to the clusters/classes. Return to ‘maps’ list. 

 

5. Save this sieved classified channel as a single layer TIF file:  

Right-click on sieve layer in maps list ->   save as ->  

Name: you pick – should have yourname e.g. jennifer-lab2 or peter-fuzzy  😊 

Format = TIFF (select from dropdown) 

 

Check all is good by loading this layer into the display: 

File-> Open -> the TIFF you just created .. it should show the saved ‘class legend’ when you 

click on pixel locations 
 

 

Lab assignment 1 (5%) 
 

Assignment questions are designed to enhance your understanding of RS data, display and 

classification. Send your text answers (Q1-3) in the message to: wheate@unbc.ca  by Friday 30 

September (6pm); no need to rewrite the question in your answer, just send in note form. 

 

These questions were posed earlier in the lab; here they are summarised: 

 

1.  What maximum threshold values did you determine for water for a. 2011  and   b. 2013 

2. What is the correlation value (r) between Red and NIR for       a. 2011 and   b. 2013 

3. The classifier often is challenged separating water from dark coniferous forest.  

a. Using either image, which one of the three bands displayed shows the biggest difference 

between these two features and explain why – click in water and forest and view the DN values 
 

b. How do you interpret the double minor modal peaks for low DNs in the 2013 NIR histogram ?   
 

4-5. email the classification tif file as an attachment ; add any comments / limitations on your 

classification to your text answers. For example, I note on my classification those boggy 

wetlands near Swamp Lake are in the same class as the Soccer fields on 15th Ave.                           

 

Next week's lab: Supervised Classification 

mailto:delgado@unbc.ca

